Contacting BMC Software

Several methods are available for contacting BMC Software.

You can access the BMC Software website at http://www.bmc.com. From this website, you can obtain information about the company, its products, corporate offices, special events, and career opportunities.

United States and Canada

<table>
<thead>
<tr>
<th>Address</th>
<th>Telephone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMC SOFTWARE INC 2101 CITYWEST BLVD HOUSTON TX 77042-2827 USA</td>
<td>1 713 918 8800 or 1 800 841 2031</td>
<td>1 713 918 8000</td>
</tr>
</tbody>
</table>

Outside United States and Canada

<table>
<thead>
<tr>
<th>Telephone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>+01 713 918 8800</td>
<td>+01 713 918 8000</td>
</tr>
</tbody>
</table>

© Copyright 2013-2015 BMC Software, Inc.

BMC, BMC Software, and the BMC Software logo are the exclusive properties of BMC Software, Inc., are registered with the U.S. Patent and Trademark Office, and may be registered or pending registration in other countries. All other BMC trademarks, service marks, and logos may be registered or pending registration in the U.S. or in other countries. All other trademarks or registered trademarks are the property of their respective owners.

Explorer is a trademark or registered trademark of Cisco Systems, Inc. and/or its affiliates in the United States and certain other countries.

DB2, IBM, RACF, and z/OS are trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or both.

The information included in this documentation is the proprietary and confidential information of BMC Software, Inc., its affiliates, or licensors. Your use of this information is subject to the terms and conditions of the applicable End User License agreement for the product and to the proprietary and restricted rights notices included in the product documentation.

Restricted rights legend

U.S. Government Restricted Rights to Computer Software. UNPUBLISHED—RIGHTS RESERVED UNDER THE COPYRIGHT LAWS OF THE UNITED STATES. Use, duplication, or disclosure of any data and computer software by the U.S. Government is subject to restrictions, as applicable, set forth in FAR Section 52.227-14, DFARS 252.227-7013, DFARS 252.227-7014, DFARS 252.227-7015, and DFARS 252.227-7025, as amended from time to time. Contractor/Manufacturer is BMC SOFTWARE INC, 2101 CITYWEST BLVD, HOUSTON TX 77042-2827, USA. Any contract notices should be sent to this address.
Customer support

Support website
You can obtain technical support from BMC 24 hours a day, 7 days a week at http://www.bmc.com/support. From this website, you can:

- Read overviews about support services and programs that BMC offers
- Find the most current information about BMC products
- Search a database for problems similar to yours and possible solutions
- Order or download product documentation
- Download products and maintenance
- Report a problem or ask a question
- Subscribe to receive proactive e-mail alerts
- Find worldwide BMC support center locations and contact information, including e-mail addresses, fax numbers, and telephone numbers

Support by telephone or e-mail
In the United States and Canada, if you need technical support and do not have access to the web, call 1 800 537 1813 or send an e-mail message to customer_support@bmc.com. (In the subject line, enter SupID:yourSupportContractID, such as SupID:12345). Outside the United States and Canada, contact your local support center for assistance.

Before contacting BMC
Have the following information available so that Customer Support can begin working on your issue immediately:

- Product information
  - Product name
  - Product version (release number)
  - License number and password (trial or permanent)

- Operating system and environment information
  - Machine type
  - Operating system type, version, and service pack or other maintenance level such as PUT or PTF
  - System hardware configuration
  - Serial numbers
  - Related software (database, application, and communication) including type, version, and service pack or maintenance level

- Sequence of events leading to the problem

- Commands and options that you used

- Messages received (and the time and date that you received them)
  - Product error messages
  - Messages from the operating system
  - Messages from related software
License key and password information

If you have questions about your license key or password, contact Customer Support through one of the following methods:

■ Send an e-mail message to customer_support@bmc.com. (In the Subject line, enter SupID:yourSupportContractID, such as SupID:12345.)

■ In the United States and Canada, call 1 800 537 1813. Outside the United States and Canada, contact your local support center for assistance.

# Contents

## About this book

- Related publications ................................................................. 9
- Conventions .............................................................................. 10
- Summary of changes ............................................................... 10

## Chapter 1  Overview of BMC Workbench for DB2

- Overview of workspaces and perspectives .................................... 15
- Overview of the BMC Workbench console ..................................... 16

## Chapter 2  Getting started

- Prerequisites ............................................................................. 19
- Logging on to BMC Workbench for DB2 ....................................... 21
- Managing user access .................................................................. 22
- Connecting to DB2 subsystems .................................................. 24
- Selecting a subsystem for the BMC Workbench repository .............. 26
- Viewing messages and UIM properties ........................................ 27
- Preparing for maintenance ....................................................... 28
- Setting BMC Workbench options .............................................. 29

## Chapter 3  Managing workspaces

- Creating a workspace .................................................................. 31
  - Creating an entirely new workspace ........................................ 32
  - Creating a workspace from a template .................................... 33
  - Saving a workspace .............................................................. 35
- Opening a workspace .................................................................. 36
- Closing a workspace .................................................................. 37
- Removing a workspace ............................................................. 37
- Editing workspace properties .................................................. 37
- Working with templates ........................................................... 38
  - Managing folders ................................................................. 39
  - Creating a template .............................................................. 40
  - Removing a template ........................................................... 41
  - Moving and editing templates .............................................. 42

## Chapter 4  Discovering DB2 subsystems and browsing catalogs

- Discovering DB2 subsystems .................................................... 45
Creating a new DB2 object view .................................................................45
Navigating through the DB2 catalog .............................................................49
Creating a DB2 statement cache view ............................................................50
Removing a view ...............................................................................................51
Copying and pasting a view ..............................................................................52
Browsing the catalog ......................................................................................52
Navigating to an object .................................................................................53
Viewing related objects ...............................................................................54
Viewing object properties ..........................................................................54
Exporting data ...............................................................................................55
Copying data ..................................................................................................56
Setting DB2 Navigator options ......................................................................57

Chapter 5 Working with commands 59
Supported commands ....................................................................................59
Generating a command ..................................................................................60
Editing text files in Scratchpad .................................................................61
Creating commands ......................................................................................64
Running a command ......................................................................................65
Setting Scratchpad options .........................................................................67

Chapter 6 Tuning SQL 69
Tuning SQL workflow ...................................................................................69
Explaining SQL statements ...........................................................................70
What-If scenarios ...........................................................................................71
  Creating a What-If scenario ......................................................................72
  Creating and editing a What-If index scenario .......................................73
Comparing statements ....................................................................................80
Selecting a statement for SQL Analysis .......................................................81
  Selecting a statement from the DB2 statement cache ...........................82
  Selecting a statement from a package ..................................................83
  Selecting an ad hoc statement ...............................................................84
SQL Tuning perspective .................................................................................85
  SQL tab ......................................................................................................88
  Indexes tab ................................................................................................88
  Explain tab ................................................................................................90
  Cost tab ......................................................................................................92
  Predicates tab ...........................................................................................92
  Compare tab ..............................................................................................93
  Related Objects tab ..................................................................................93
  Output tab ................................................................................................95

6  BMC Workbench for DB2 User Guide
About this book

This book contains detailed product information and is intended for application developers and database administrators (DBAs).

Like most BMC documentation, this book is available in printed and online formats. To request printed books or to view online books and notices (such as release notes and technical bulletins), see the support website at http://www.bmc.com/support.

**Note**

Online books are formatted as PDF or HTML files. To view, print, or copy PDF books, use the free Adobe Reader from Adobe Systems. If your product installation does not install the reader, you can obtain the reader at http://www.adobe.com.

The software also offers online Help. To access Help, press **F1** within any product or click the **Help** button in graphical user interfaces (GUIs).

Related publications

From the BMC Support Central website, you can use the following methods to access related publications that support your product or solution:

- Link to the BMC Documentation Center (https://webapps.bmc.com/infocenter/index.jsp) to browse documentation sets.

- View Quick Course videos (short overviews of selected product concepts, tasks, or features), which are available from the following locations:
  - Documentation Center
  - Support Central (at http://www.bmc.com/support/mainframe-demonstrations)
  - BMC Mainframe YouTube channel (https://www.youtube.com/user/BMCSoftwareMainframe)
• View individual product documents (books and notices) within the “A – Z Supported Product List.”

You can order hardcopy documentation from your BMC sales representative or from the support site. You can also subscribe to proactive alerts to receive e-mail messages when notices are issued.

**Tip**
You can access the BMC Support Central site at [http://www.bmc.com/support](http://www.bmc.com/support).

### Conventions

This document uses the following special conventions:

• All syntax, operating system terms, and literal examples are presented in this typeface.

• Variable text in path names, system messages, or syntax is displayed in italic text: `testsys/instance/fileName`

• Menu sequences use a symbol to convey the sequence. For example, **Actions => Create Test** instructs you to choose the **Create Test** command from the **Actions** menu.

### Summary of changes

This topic summarizes product changes and enhancements.

**Version 1.0.00 January 2015**

This release adds the following new feature and enhancement:

• **Result Sets and Output Summary**
  You can now view a chronological summary of DB2 Commands and SQL Statements executed in Scratchpad. You can select and view specific outputs or result sets, either directly from the summary or from the command bar.

• **The SELECT statement is no longer limited to a single table or view, and now has the same limitations as other statements generated from within Workbench.**
Version 1.0.00 September 2014

This release adds the following new features:

■ When you add a DB2 Object view, you can now use advanced search to narrow down the result by providing additional search criteria. You create a search clause that uses one or more column values and standard operators. For more information, see “Creating a new DB2 object view” on page 45 and view the Quick Course "Workbench for DB2 - Performing advanced search."

■ You can now use System Authorization Facility (SAF) resources to manage individual user-access to Workbench functions. For more information, see “Managing user access” on page 22.

Version 1.0.00 June 2014

This release adds the following new features:

■ From most navigation trees and results views, you can now access relevant menu options by right-clicking.

■ This release includes the following new commands:
  — Copy lets you copy selected data to the clipboard
  — Export Data lets you export selected data into a .csv file.

■ BMC Workbench now supports the following DML statements:
  — SELECT
    
    **Note**
    
    Also, new options in the Scratchpad options dialog box and SQL Tuning options dialog box let you configure values for your SELECT statements (such as maximum CHAR and VARCHAR lengths). For more information, see “Setting Scratchpad options” on page 67 or “Setting SQL tuning options” on page 95.

  — INSERT
  — UPDATE
  — DELETE
You can generate DML statements from the DB2 Navigator perspective. You can execute them from the Scratchpad or directly from the SQL Tuning perspective.

For more information, view the Quick Course "Workbench for DB2 - Generating DML."

- In the File Locator perspective, you can now open a folder or a file by double-clicking it in the results pane. Previously, you could only open a folder in the navigator pane.

**Version 1.0.00 January 2014**

This release adds the following new features:

- A Template Manager lets you organize templates hierarchically in user-defined folders, making it easier to find the templates that you need.

- A Connection Manager lets you to define a local or a remote DB2 connection via a single UIM server.

- Authorized users can use the new superuser authorization to: edit or delete connections or templates owned by any user:
  - Edit or delete connections or templates owned by any user
  - Create public connections

- A DB2 repository selected by the superuser, now stores all user related information, including user preferences, workspaces, connections, and templates.

- This release adds support for the following additional DB2 objects in the DB2 Navigation perspective:
  - Image Copies
  - Table Constraints

**Version 1.0.00 October 2013**

This release adds a What-If index feature that enables you to evaluate the potential performance of a SQL statement by creating an index, dropping an index, or updating index statistics. This feature is available if you have a license for BMC Performance for DB2SQL.
Version 1.0.00 June 2013

This version is the original release of the product.
Overview of BMC Workbench for DB2

The BMC Workbench for DB2 product offers a web-based graphical user interface (GUI) to IBM DB2 application developers and DBAs. With BMC Workbench, you can use a web browser (Microsoft Internet Explorer, Google Chrome, or Mozilla Firefox) to perform common tasks on your IBM z/OS mainframe.

BMC Workbench includes the following features:

- **Browsing the DB2 catalog and data sets**
  You can browse a DB2 object or set of objects, or any DB2 statement in the DB2 statement cache or in a package. You can also browse data set members and use the Scratchpad text editor to edit them.

- **Tuning SQL statements**
  For a selected statement, you can create alternative What-If options, use graphical Explain plans to compare the alternatives, and then tune your statement accordingly. In the graphical Explain plan, nodes represent each step in the statement; clicking a node displays details for that step from the Explain plan tables.

- **Viewing jobs and job output**

- **Executing DB2 commands**
  You can navigate to a DB2 object and display and edit the syntax of a command for any of the supported DB2 commands. For details of supported commands, see “Supported commands” on page 59.

Overview of workspaces and perspectives

All work in BMC Workbench is performed within workspaces. You can define as many workspaces as you need, and no other users can view or edit your workspaces. You can create a workspace template, which can be used by other users to create workspaces with the same set of views.
Each workspace has several *perspectives*. A perspective contains command options to perform a set of tasks, such as tuning SQL statements or running DB2 commands. The perspective displays results relating to different objects or statements in user-defined *views*. For example, you might define a view to display a subset of DB2 objects in the DB2 Navigator perspective. Performing certain actions on an object can automatically switch the perspective and open the corresponding view to display the relevant content.

For more information, view the Quick Course "Workbench for DB2 - Understanding Perspectives."

During a session, you can save a workspace at any time and return to it later in that session or another session. Workspace filters preserve your working environment. Consequently, you can partially complete a task (such as tuning SQL), save your workspace, and address another task that requires immediate attention; when time permits, you can return to your saved tuning session and continue creating What-If scenarios.

**Overview of the BMC Workbench console**

The BMC Workbench *for DB2* main console is displayed after you log on to BMC Workbench. The product’s web-based console has one pane for managing workspaces and another for working with your DB2 objects and data sets.
When you first launch the product, the console features a welcome screen. Creating your first workspace enables all of the tools in the Workspace Manager toolbar and switches the focus in the right pane to the DB2 Navigator perspective.

Figure 1: Sample BMC Workbench console

Legend

<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Workspace Manager pane</td>
<td>Lists all of your workspaces</td>
</tr>
<tr>
<td>2</td>
<td>Workspace Manager toolbar</td>
<td>Lets you create, open, and save workspaces</td>
</tr>
<tr>
<td>3</td>
<td>Active workspace name</td>
<td>Indicates which workspace is active</td>
</tr>
<tr>
<td></td>
<td></td>
<td>An asterisk (*) indicates that the workspace has unsaved changes.</td>
</tr>
<tr>
<td>4</td>
<td>DB2 navigation pane</td>
<td>Lists all of the views that are in the currently open perspective</td>
</tr>
<tr>
<td>5</td>
<td>Perspective tabs</td>
<td>Provides access to the specified perspective. The current open perspective is indicated in blue</td>
</tr>
<tr>
<td>6</td>
<td>Navigate To toolbar (DB2 Navigator perspective only)</td>
<td>Lets you navigate to object types that are dependents of the selected object in the results list</td>
</tr>
<tr>
<td>7</td>
<td>Commands toolbar (DB2 Navigator perspective only)</td>
<td>Lets you execute commands on the selected object, display properties, and display explainable statements.</td>
</tr>
<tr>
<td>#</td>
<td>Description</td>
<td>Details</td>
</tr>
<tr>
<td>----</td>
<td>---------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>8</td>
<td>View toolbar</td>
<td>Lets you perform actions on an object selected in the results pane. The available options vary according to the type of object selected.</td>
</tr>
<tr>
<td>9</td>
<td>What's New</td>
<td>Lets you view details and short videos describing the new features added to BMC Workbench</td>
</tr>
<tr>
<td>10</td>
<td>Tools</td>
<td>Lets you access system messages, set global options, and view details of the User Interface Middleware (UIM).</td>
</tr>
<tr>
<td>11</td>
<td>Logout</td>
<td>Lets you logout from the BMC Workbench</td>
</tr>
<tr>
<td>12</td>
<td>Results pane</td>
<td>Displays the results that a perspective generates, based on the type of action performed</td>
</tr>
<tr>
<td>13</td>
<td>Options button</td>
<td>Lets you set options for the currently displayed perspective</td>
</tr>
<tr>
<td>14</td>
<td>Close Workspace button</td>
<td>Closes the active workspace</td>
</tr>
<tr>
<td>15</td>
<td>Help button</td>
<td>Displays the online Help</td>
</tr>
<tr>
<td>16</td>
<td>Results list (DB2 Navigator perspective only)</td>
<td>Displays all objects that correspond to the filter definition (for example, all objects returned by a filter in DB2 Navigator)</td>
</tr>
</tbody>
</table>
Getting started

After installing the BMC Workbench for DB2 product, you must perform the following tasks before you can use the product:

1 “Logging on to BMC Workbench for DB2” on page 21
2 “Managing user access” on page 22
3 “Selecting a subsystem for the BMC Workbench repository” on page 26
4 “Setting BMC Workbench options” on page 29
5 “Creating an entirely new workspace” on page 32

Prerequisites

You can install BMC Workbench for DB2 from the Installation System.

Additional requirements are as follows:

License

To run BMC Workbench, you must have a license for one of the following solutions:

- BMC Object Administration for DB2
  This license enables the following premium features: HDDL and Drop Recovery.

- BMC Performance for DB2 SQL
  This license enables the What-If index premium feature.

You can install BMC Workbench together with one of these solutions or separately, at a later time.
Supported browsers

- BMC Workbench supports the following browsers on Microsoft Windows 7. BMC has tested BMC Workbench on the specific version numbers cited:
  - Microsoft Internet Explorer 8, 9
  - Mozilla Firefox 18 or later
  - Google Chrome 23, 24, or later
- Adobe Flash Player version 11.2.0 or later must be installed.

DB2 privileges

**Note**
Information provided in this section supplements the information detailed in relevant section of the *BMC Products and Solutions for DB2 Configuration Guide*.

You must have READ/WRITE privileges to the BMC Workbench repository. The default CREATOR for these tables is BMCGUD.

SAF authorization

Use the following procedure to verify that you can access the BMC Workbench functions that you need.

**Note**
This information supplements the BMC Workbench security configuration information in the *BMC Products and Solutions for DB2 Configuration Guide*.

   For more information about accessing functions, see “Managing user access” on page 22.
2. If you require access to additional functions, contact the person who administers BMC Workbench in your installation.

Component configuration

The following configuration requirements apply to the components that work with BMC Workbench.

User Interface Middleware (UIM)
You must have READ/WRITE privileges for the UIM HFS data set.

The following new requirements apply if you have multiple BMC Workbench installations sharing a single repository:

— You can have only one UIM HFS data set per repository. If multiple UIMs share a repository, they must also share the UIM HFS data set.

— All BMC Workbench installations must have the same maintenance level (same PTFs).

DB2 Component Services (DBC)

BMC Workbench uses GUD agents that require the DB2 DSNLOAD library. Unless that library is already included in your LINKLIST, you must add the DB2 DSNLOAD library to the <LOADLIB> tags in the GUDINIT step of the $U20INIT job.

For more information, search the Knowledge Base for article KA412340. You can access the Knowledge Base directly at https://kb.bmc.com/infocenter or from the BMC Support Central website (http://www.bmc.com/support).

Logging on to BMC Workbench for DB2

Use the following procedure to log onto BMC Workbench for DB2 from your web browser.

**Before you begin**

Verify that the following requirements are met:

- The required User Interface Middleware (UIM) server is running.

- You have a user ID and password with:
  - Authorization to access the host where the UIM server is installed
  - Suitable DB2 authorization for your requirements

- You know the host name of the UIM server that is connected to your DB2 server, and the port number on which the UIM server is listening.

- The DBC started task is running and the DB2 Product Configuration (LGC) agent is active.
If you are using a security package like IBM Resource Access Control Facility (RACF), or CA Technologies CA-ACF2 or CA-Top Secret, ensure that you know the ID and account details.

**To log on**

1. In a web browser, enter the URL `http://host:port/workbench/index.html`. Replace the variables `host` and `port` with the host name and port number of the UIM server.

   **Tip**
   
   To simplify future access, save the URL as a favorite.

2. In the Logon dialog box, enter your TSO user ID and password.

3. *(optional)* If using a security package like RACF, CA-ACF2, or CA-Top Secret, enter your group ID and account number.

4. Click **OK**.

   The Welcome screen is displayed.

   **Note**
   
   If you are inactive for 30 minutes, BMC Workbench console times out and you must reenter your password.

**Where to go from here**

If this is the first time that you logged on to BMC Workbench, you must create a workspace to proceed.

**Related Information**

- “Creating an entirely new workspace” on page 32

**Managing user access**

By default, licensed users have full access to all BMC Workbench functions. Using the following procedures and the System Authorization Facility (SAF), you can...
disable perspectives for one or more users, or assign superuser authorization to a user.

**Note**

You cannot disable access to Workspace Manager or to the DB2 Navigator perspective.

**For ACF2 users**, to create a superuser or to manage user-access to BMC Workbench functions, define the resource as TYPE(XFC) where the documentation refers to the RACF XFACILIT class.

---

**Before you begin**

You must have SAF authorization that enables you to create and assign the required resources.

**To create and assign authorizations**

1. For each UIM installation, create any of the following SAF resources that you need as a XFACILIT class:

<table>
<thead>
<tr>
<th>Manage this perspective</th>
<th>Create this SAF resource</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Locator</td>
<td>BMCGUD.WBAC.%SYSNAME%.%PORT%.FILE_LOCATOR</td>
</tr>
<tr>
<td>Job Browser</td>
<td>BMCGUD.WBAC.%SYSNAME%.%PORT%.JOB_BROWSER</td>
</tr>
<tr>
<td>SQL Tuning</td>
<td>BMCGUD.WBAC.%SYSNAME%.%PORT%.SQL_TUNING</td>
</tr>
<tr>
<td>Scratchpad</td>
<td>BMCGUD.WBAC.%SYSNAME%.%PORT%.SCRATCHPAD</td>
</tr>
</tbody>
</table>

2. Replace the variables `%SYSNAME%` and `%PORT%` with the system name and the port number of the UIM server.

**To assign superuser authorization**

With superuser authorization, a user can edit and delete connections or templates owned by any user, and create or delete public connections. The user who sets up the BMC Workbench repository requires superuser authorization.

Superuser authorization is specific to each UIM. If your site stores public connections and templates on several sysplexes according to business function, you can provide superuser authorization to specific users based on their areas of responsibility.

**Note**

If you previously used `(ACT.WBSU.%HOST%.%PORT%)`, to define a superuser, you do not need to change it.
For each UIM installation, create the following SAF resource as a XFACILITclass:

BMCGUD.WBSU.%SYSNAME%.%PORT%

Replace the variables %SYSNAME% and %PORT% with the system name and port number on the UIM server.

Assign ALTER authority to the superuser resource for the user requiring superuser authorization on that UIM.

**Connecting to DB2 subsystems**

During initialization, BMC Workbench discovers all DB2 subsystems on the sysplex where a UIM server is installed. These are listed in the DB2 connections menu. You can also add connections to remote DB2 subsystems.

For more information, view the Quick Course "Workbench for DB2 - Using the Connection Manager."

When you initially open the Connection Manager, a table of discovered connections is displayed. You can add connections. The type of connection is indicated by an icon. Unless you are a superuser, you can only see your own, public connections, and discovered connections.

**Table 1: Connection type icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="User Icon" /></td>
<td>DB2 connections that you own</td>
</tr>
<tr>
<td><img src="image" alt="Connections Icon" /></td>
<td>DB2 connections discovered by Connection Manager, these cannot be removed by anyone including a superuser</td>
</tr>
<tr>
<td><img src="image" alt="Public Icon" /></td>
<td>Public DB2 connections created by a superuser</td>
</tr>
<tr>
<td><img src="image" alt="Connections Icon" /></td>
<td>Non-public DB2 connections visible to superusers, but owned by other users</td>
</tr>
</tbody>
</table>

**To add a DB2 connection**

You might want to give an easily identifiable name to a local DB2 connection or create a remote DB2 connection. Only you and superusers can view, use, and edit connections that you have created.

1. On the browser's main menu bar, click **Tools => Manage Connections.**
Click +.

3. Complete the Add DB2 Connection dialog box.
   a. Enter a name that describes the connection.
   b. Select a local subsystem.
   c. If you want to connect to a remote subsystem, enable Remote Subsystem and from the menu, select a remote subsystem that is connected to the selected local subsystem.
   d. Superusers can enable Public to create public connections. Public connections can be used by all users.
   e. Click OK.

To remove a DB2 Connection

Unless you are a superuser, you can only edit or remove DB2 connections that you created. See Table 1 on page 24.

**Note**

You cannot remove a DB2 connection if a workspace is using it.

1. On the browser's main menu bar, click **Tools => Manage Connections**.
2. Select a DB2 connection that you can edit.
3. Click -.
4. When asked, click Yes to confirm the operation.

To edit the list of favorite DB2 connections

You can filter the list of favorite DB2 connections to display only those that are relevant to you. This list populates the menu of DB2 connections from which you select a connection. Until you make a selection, all the available connections are dimmed.

**Tip**

In many dialog boxes, where you are required to select a DB2 connection, you can also edit the list of favorites by clicking next to the **DB2 Connection** field.

1. On the browser's main menu bar, click **Tools => Manage Connections**.
The Connection Manager displays all the subsystems that are automatically discovered, public DB2 connections, and any DB2 connections that you create. The favorite icon ★ next to each DB2 connection indicates whether the DB2 connection is included in the list of favorites. ★ is dimmed (☆) if the DB2 connection is excluded from the list.

**Tip**

Click ⇨ to update the list of discovered subsystems, for example if you have restarted a DB2 server or public connections that have been added during your session by a superuser.

2 Select a DB2 connection and on the command bar, edit the list of favorite connections:

- Click ★ to include in the list.
- Click ☆ to exclude from the list.

3 Repeat until you have created your list of favorites, then click OK.

### Selecting a subsystem for the BMC Workbench repository

Product information, such as user preferences and workspaces, is saved in a repository on a DB2 subsystem.

Only BMC Workbench superusers (see “Managing user access” on page 22) can select the DB2 subsystem where the repository is installed.

**Tip**

After you have stored user preferences and workspaces, *BMC recommends that you do not change where the repository is installed*. If you have to change your repository, contact BMC support for advice.
Consider the following guidelines if you have BMC Workbench installations sharing a single repository:

- There must be only one UIM HFS data set per repository. If multiple UIMs share a repository, then they must also share the UIM HFS data set.

- All BMC Workbench installations must have the same maintenance level (that is, same PTFs applied).

To select the subsystem

1. On the browser's main menu bar, click **Tools => Server Setup**.
2. Select **Workbench Repository**.
3. Select a DB2 subsystem and click **OK**.

Viewing messages and UIM properties

Use the following procedure to view the system information, warning, error, and debug messages. You can also view the properties of the User Interface Middleware (UIM) Server that is connected to your DB2 server.

To view messages

1. On the BMC Workbench console's main menu, click **Tools => View Messages**.

   The View Messages screen displays messages chronologically. By default, only system messages are displayed.

2. You can perform the following tasks:
   - To view debug messages, select **Show debug messages**.
   - To refresh the display, click **Refresh**.
   - To change the size of the View Messages screen, click and drag the bottom right corner of the View Messages screen.
   - To save the messages, click **Save Messages**.

   Only the currently displayed messages are saved. Debug messages are saved only if you have **Show debug messages** checked.
To clear the message display, click Clear Messages.

To view UIM details

2. Select Server Information.

The properties of the UIM Server are displayed.

Preparing for maintenance

When the DB2 subsystem that hosts the repository is offline for maintenance, the repository is unavailable. Use the following procedure to maintain access to repository information, such as preferences, templates, and saved workspaces.

**Note**
You can skip this procedure if you do not need access to the repository. For example, you can skip it but continue using BMC Workbench if you do not need to access information, save workspaces, or create connections through Connection Manager.

To prepare for DB2 maintenance

1. Create the repository by installing BMC CATALOG MANAGER for DB2 on the fallback DB2 subsystem.

   If BMC Workbench was installed using version 2.3.60 of the BMC Installation System and installation media, install the repository tables as instructed in the BMC Workbench for DB2 Technical Bulletin dated March 6, 2014.

2. If the ACTWBREP package is not bound on the fallback subsystem, bind the package as follows:
   a. Enter CATALOG MANAGER or BMC Workbench.
   b. Use DB2 Navigator to select the package (ACTWREB).
   c. Perform a Bind or Rebind action.

3. Migrate the data by unloading it from the current subsystem and loading it on the fallback subsystem.

4. Run Runstats on the fallback subsystem.
5 Log on to BMC Workbench as a superuser and select the fallback DB2 subsystem as the repository.

Enter CATALOG MANAGER or BMC Workbench.

See “Selecting a subsystem for the BMC Workbench repository” on page 26.

--- Note ---
Consider the following guidelines if you have BMC Workbench installations sharing a single repository:

- There must be only one UIM HFS data set per repository. If multiple UIMs share a repository, then they must also share the UIM HFS data set.
- All BMC Workbench installations must have the same maintenance level (that is, same PTFs applied).

After the maintenance is complete, perform Step 3 on page 28 to Step 5 on page 29 with the original subsystem being the recipient.

--- Setting BMC Workbench options ---

Use the following procedure to enable certain settings and troubleshooting tools that affect all perspectives.

--- Note ---
To set options for a particular perspective only, you would use the Options button.

1 On the browser's main menu bar, click Tools => Options.

2 Select the General tab.

3 Select Filter Options. In all perspectives, this option converts all entered filter values to upper case.

--- Note ---
If you select (enable) this option, you can override it for a specific filter by beginning the filter value with a quotation mark (").

- Leave the check box selected if you want BMC Workbench to convert all filter values that you enter to uppercase (default).
- Clear the check box if you want to preserve the case that you use when typing filter values.

**Note**

The Support tab provides access to product trace options. Use these options only when requested to do so by BMC Customer Support.
Managing workspaces

In BMC Workbench for DB2, you perform all of your activities in workspaces. Use the Workspace Manager to create and manage your workspaces.

After installing and logging onto BMC Workbench, you must create a workspace before you can start using the product. Each workspace has several perspectives, and each perspective can contain one or more views.

Creating a workspace

In BMC Workbench for DB2, you can create an entirely new workspace, create a workspace from a template, or copy an existing workspace.

For more information, view the Quick Course "Workbench for DB2 - Creating a Workspace."

The Workspace icon indicates the current status of the Workspace. The following statuses can be displayed:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Image" /></td>
<td>New workspace</td>
<td>The workspace has been created and is unsaved.</td>
</tr>
<tr>
<td><img src="image2" alt="Image" /></td>
<td>Open workspace</td>
<td>The workspace has been opened in this session.</td>
</tr>
<tr>
<td><img src="image3" alt="Image" /></td>
<td>Edited workspace</td>
<td>Unsaved changes have been made to the workspace.</td>
</tr>
<tr>
<td><img src="image4" alt="Image" /></td>
<td>Inactive workspace</td>
<td>The workspace has not been opened in this session.</td>
</tr>
</tbody>
</table>
Creating an entirely new workspace

Use the following procedure to create a new workspace that is not based on a template or an existing workspace.

**To create an entirely new workspace**

1. In the Workspace Manager, click **Add Workspace**.

2. In the Add Workspace dialog box, enter a workspace name and (optionally) a description for the workspace.

   The name of the workspace must be unique for the user ID.

   **Note**

   In the Workspace Manager, the asterisk beside the workspace name indicates that the workspace is new or contains unsaved changes. The Workspace icon is displayed as ![Icon](image).

3. Click **Save Workspace** to save the workspace.

   The Workspace icon is displayed as ![Icon](image).

**Where to go from here**

After you create a workspace, you can perform the following tasks:

- “Discovering DB2 subsystems” on page 45
- “Tuning SQL” on page 69
- “Working with commands” on page 59
Creating a workspace from a template

Use the following procedure to create a new workspace from any template that is stored in the template repository.

To create a workspace from a template

1. From the Workspace Manager, click Create Workspace from Template.

2. In the Create Workspace from Template dialog box, search for the required template:
   - From the Filter by owner menu, select a user name.
     Only the templates belonging to the selected user are displayed. You can use this filter in combination with the search string.
   - Enter a search string into the search field.
     As you enter the search string, matching folders and templates are displayed in a search list.
   - Use the vertical scroll bar or the mouse to navigate to and select the template that you want from the list.
   - Select the folder that contains the required template, and expand to search within the folder.
To view the owner, description and the time that the template was last modified, hover over the template name.

**Note**
In this dialog box, you can also create new folders, move and edit your folders. For more information, see “Managing folders” on page 39

3 Enter a workspace name and *(optionally)* a description.

4 Click **Create Workspace**.

**Note**
In the Workspace Manager, the asterisk beside the workspace name indicates that the workspace is unsaved or contains unsaved changes.

The Workspace icon is displayed as 

5 Click **Save Workspace**.

The Workspace icon is displayed as 

**Where to go from here**

After you create a workspace, you can perform the following tasks:

- “Discovering DB2 subsystems” on page 45
- “Tuning SQL” on page 69
- “Working with commands” on page 59
- “Managing JES jobs” on page 99
- “Managing data sets” on page 101
Saving a workspace

Saving a workspace enables you to close a workspace or log out from BMC Workbench for DB2 and return with the same defined definitions. If the workspace is not saved, any changes or additions made since the last save are not available when you log on again to the BMC Workbench console.

Note

All unsaved workspaces are indicated by an asterisk beside the workspace name and the Workspace icon is displayed as new workspace or edited workspace.

To save a workspace

1. Select a workspace.
2. Select one of the following options:
   - **Save a Workspace**
   - **Save All Workspaces**
   - **Save Workspace As** to save under a different name
   - **Create Template** to save the workspace as a template that others can find and copy (as explained in “Creating a template” on page 40). This option does not save the workspace itself. If you have not saved changes to the workspace, the workspace icon remains.
Opening a workspace

The last active workspace is always displayed when you reopen BMC Workbench for DB2. You can open any workspace from the Workspace Manager.

To open a workspace

1. In the Workspace Manager, perform one of the following:
   - Double-click the required workspace.
   - Select the workspace from the list, and click Open Workspace.

A new workspace opens in the DB2 Navigator perspective, and workspaces that were previously saved are opened in the perspective that was active when saved.

Note
When you hover over a workspace listed in the Workspace Manager, you can view the owner, description and the time that the workspace was last updated.

Where to go from here

You can add or remove views from the workspace.

Related Information

- “Creating a DB2 statement cache view” on page 50
- “Creating a new DB2 object view” on page 45
- “Removing a view” on page 51
Closing a workspace

Next time that you open a workspace that you closed, Workbench displays the perspective that was active when the workspace was last saved.

To close the workspace

1. Click Close workspace (positioned at the extreme top-right of the screen).

   Note
   If the workspace has unsaved work, you are asked if you want to close the workspace and discard your changes.

Removing a workspace

Use the following procedure to remove or delete a workspace that you no longer need.

To remove a workspace

1. In the Workspace Manager, select the workspace that you no longer need.

2. Click Remove Workspace.

3. When asked to confirm the action, click Yes.

Editing workspace properties

Use the following procedure to change a workspace's name or description.

To edit the workspace properties

1. In the Workspace Manager, select the required workspace.

2. Click Edit Workspace Info.

   The Edit Workspace Info dialog box is displayed.
3 Make changes to the name, description, or both.

4 Click OK.

**Related Information**

- “Saving a workspace” on page 35

---

**Working with templates**

You can use any workspace as a template, and you can create new workspaces from templates that you or other users have created. Each template contains a set of views.

All templates are saved to a repository database and are available to all BMC Workbench users that have suitable DB2 authorization to access it.

For more information, view the Quick Course "Workbench for DB2 - Using the Template Manager."

**Example**

A DBA creates a workspace that includes a set of filters for DB2 Navigation; the filters specify a specific set of tables for accounting software that runs on a specific DB2 subsystem. The DBA saves the workspace as a template. The template is then available to all users, which saves the time and effort that would be required to create the workspace again from scratch.

**Related Information**

- “Overview of workspaces and perspectives” on page 15
- “Managing folders” on page 39
- “Creating a template” on page 40
- “Removing a template” on page 41
- “Moving and editing templates” on page 42
- “Creating a workspace from a template” on page 33
Managing folders

Templates are saved to public folders, which can contain templates of one or more users.

You can also add, delete, and edit folders when you create a workspace from a template or when you create a template.

To create a folder

Any user can create a folder, this folder can be accessed and used by all other users.

1. On the browser's main menu bar, click **Tools => Manage Templates**.
   
   A folder tree is displayed, which shows all the templates stored in the repository.

2. In the folder tree, navigate to and select the intended parent folder or select *Templates* to create a folder in the root.

3. Click **+**.

4. Enter a valid folder name.
   
   The name can only contain up to 50 characters, the following are allowed:
   
   - Alphanumeric (not case sensitive)
   - Space
   - Dash (-)
   - Underscore (_)

   **Note**
   Leading and trailing spaces are removed

5. Click **OK**.

To delete a folder

You can delete any empty folder.

1. On the browser's main menu bar, click **Tools => Manage Templates**.

   A folder tree is displayed.
2 Navigate to and select the folder to be deleted.

3 Click \(\rightarrow\).

4 Click Yes to confirm the deletion.

**To move a folder**

1 On the browser's main menu bar, click **Tools => Manage Templates**.
   A folder tree is displayed.

2 Select the folder that you want to move.

3 Click \(\rightarrow\).

4 Select a new parent folder.

5 Click OK.

**To change a folder name**

1 On the browser's main menu bar, click **Tools => Manage Templates**.

2 In the folder tree, navigate to and select the folder name that you want to change.

3 Click \(\rightarrow\).

4 Enter a new valid name.
   See “To create a folder” on page 39 for permitted characters.

5 Click OK.

**Creating a template**

Use the following procedure to create a template from any workspace. You or your team can make a set of templates for different purposes.

**To create a template**

1 In the Workspace Manager, open the workspace that you want to use as a template.
2 Click Create Template.

*Note*
In the Create Template dialog box, you can also create new folders and edit your folders. For more information, see “Managing folders” on page 39.

3 In the Create Template dialog box enter:

- A template name
  The name can only contain up to 50 characters, the following are allowed:
  - Alpha-numeric (case-insensitive)
  - Space
  - Dash (-)
  - Underscore (_)
  
  *Note*
  Leading and trailing spaces are removed

- (optionally) A template description
  The description enables other users to identify the template as one that suits their purposes.

- Select or create a folder where you want to save the template:
  - Navigate to and select the folder where you want to save the template.
  - Click to add a folder. For details, see “Managing folders” on page 39.

4 Click Create Template.

**Related Information**

- “Creating a workspace from a template” on page 33

---

**Removing a template**

Unless you are a superuser, you can remove only templates that you own.
To remove a template

1. On the browser's main menu bar, click **Tools => Manage Templates**.

   A folder tree is displayed.

2. Filter, navigate to, and select a template to be deleted. Use **Ctrl+Click** to select more than one template.

3. Click **delete**.

4. Click **Yes** when you are asked to confirm the action.

Moving and editing templates

Use these procedures to move your templates between folders and edit template information.

Unless you are a superuser, you can move and edit only templates that you created.

**Tip**

You can also access the Manage Templates dialog box from the Create Template command.

To move a template to a different folder

1. On the browser's main menu bar, click **Tools => Manage Templates**.

   A folder tree is displayed.

2. Unless you are a superuser and intend to move another user's templates, select your user name from the **Filter by owner** menu, and filter the templates so that you can see only templates that you created.

3. If you want to move the template to a new folder, create the new folder. For more details, see “To create a folder” on page 39

4. Navigate to and select the template to be moved.

5. Click **delete**.

6. Navigate to and select the target folder.
7 Click OK.

**To edit a template's information**

1 On the browser’s main menu bar, click **Tools => Manage Templates**.

2 Unless you are a superuser and intend to edit another user's templates, select your user name from the **Filter by owner** menu, and filter the templates so that you can see only templates that you created.

3 Navigate to and select the required template.

4 Click ![template icon].

5 Edit the template name and description.

6 Click OK.
Working with templates
Discovering DB2 subsystems and browsing catalogs

BMC Workbench for DB2 enables you to discover DB2 subsystems, and then browse through the DB2 catalog tables where you can select, view properties, and perform actions on DB2 objects.

Discovering DB2 subsystems

Sysplex discovery occurs during BMC Workbench for DB2 initialization.

BMC Workbench discovers all DB2 subsystems on the sysplex where a UIM server is installed; however, the filtering mechanism prevents you from viewing and connecting to subsystems running on DB2 versions that are not supported by BMC Workbench. If you have multiple sysplexes, you must install a UIM on each sysplex. For more information, see the Installation System Reference Manual and Installation System Quick Start.

Note

BMC Workbench strictly maintains DB2 authorization rules; you can access DB2 objects on a subsystem only if you have the appropriate authorization in DB2.

Creating a new DB2 object view

Use the following procedure to create a view in a workspace. Each view contains a subset of DB2 objects retrieved from a DB2 subsystem. This topic also explains how to build an advanced search to use as the basis for the new view.

To create a DB2 object view

1. Open or create a workspace.
2 In the DB2 Navigator perspective, click **Add DB2 Object View**.

*Tip*
You can also right-click in the DB2 navigation pane to select this action.

3 In the Add DB2 Object View dialog box, complete the following fields or accept the displayed default values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2 Connection</td>
<td>Use either of the following methods:</td>
</tr>
<tr>
<td></td>
<td>■ Type the full or partial name of a DB2 connection to select the first subsystem that matches this value in the list of favorite connections.</td>
</tr>
<tr>
<td></td>
<td>■ Use the menu arrow to select from your list of favorite connections.</td>
</tr>
<tr>
<td></td>
<td><em>Tip:</em> You can add DB2 connections to your list of favorite connections by clicking and specifying which connections to include.</td>
</tr>
<tr>
<td>Object Type</td>
<td>Select an object type.</td>
</tr>
</tbody>
</table>

4 Create either a basic search or an advanced search to use as the basis for the new view:

■ For a basic search, enter a filter pattern for the selected object.

■ For an advanced search, click **Advanced Search** and complete the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Label</td>
<td><em>(optional)</em> Enter a label for this view. The default name is the first 30 characters of the search clause.</td>
</tr>
<tr>
<td>String Delimiter</td>
<td>From the menu, select <strong>Apostrophe</strong>, <strong>Quotation mark</strong>, or <strong>None</strong> as the string delimiter for character-type columns.</td>
</tr>
<tr>
<td>Search clause builder</td>
<td>Build an advanced search clause as instructed in “To build an advanced search clause for a view” on page 47.</td>
</tr>
</tbody>
</table>

5 Click **OK**.
The view is now included in the DB2 navigation pane, in a hierarchical display organized by subsystem and type.

---

**Note**

identifies a view created from a basic search, and identifies one created from an advanced search.

---

6 When finished, save the workspace.

**To build an advanced search clause for a view**

The search clause is built from rows of search criteria in a grid. You can add, remove, and move rows to fine-tune the search clause.

As you enter the search criteria and build the search clause, it is displayed in the **Search Clause** text area below.

---

**Note**

By default, column names are displayed in catalog order. You can change to alphabetical order by clicking **Options** and changing the setting.

---

1 In the **Column** column, click the empty cell and either select a column from the displayed list or type a column name.

   BMC Workbench selects a matching column name in the list based on your entry; the list includes all column names for the DB2 connection and object type.

2 In the **Operator** column, click the cell and select an operator.

   **Note**
   
   The LIKE operator accepts only DB2 wildcards (% and _)

3 Click in the **Value** column and add a value.

   The value is case sensitive and is automatically enclosed in the delimiter that you selected.

   **Note**
   
   BMC Workbench requires a nonblank value but does not validate this value.

4 Click in the **And/Or** column and select one of the following options:

   - AND
   - OR
- (which closes the search clause)

If you select **AND** or **OR**, you are prompted to enter another column name, operator, and value in the row below.

5 Continue adding rows until you have built the search clause, ending the clause with `-`.

6 **(optional)** If you want to make any changes, edit the search criteria as follows:

Use the following buttons to add, remove, or move rows. (You can perform the same operations by right-clicking in a row and selecting the appropriate command.)

### Table 2: Search criteria grid buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="add.png" alt="Add" /></td>
<td>Adds a row to the <strong>Search Clause</strong> criteria grid</td>
</tr>
<tr>
<td><img src="remove.png" alt="Remove" /></td>
<td>Removes the selected row from the grid</td>
</tr>
<tr>
<td><img src="move-up.png" alt="Move Up" /></td>
<td>Moves the selected row up</td>
</tr>
<tr>
<td><img src="move-down.png" alt="Move Down" /></td>
<td>Moves the selected row down</td>
</tr>
</tbody>
</table>

In the grid, selecting a row and clicking ![Add](add.png) adds a row above the one that you selected.

### Table 3: Search Clause text area controls

You can edit the search clause directly by typing in the search clause text area.

**Note:**
The changes that you type into the text area are not synchronized with the search criteria in the grid. The grid is disabled.

To edit the search clause directly, use the following buttons or shortcut keys:

<table>
<thead>
<tr>
<th>Button or Shortcut key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Column</strong> or <strong>Alt+Ctrl+Space</strong> key</td>
<td>Click in the clause and, from the menu, select a column name to add to the search clause</td>
</tr>
<tr>
<td><strong>Operator</strong> or <strong>Alt+Ctrl+o</strong></td>
<td>Click and, from the menu, select a operator to add to the search clause.</td>
</tr>
</tbody>
</table>
### Button or Shortcut key | Description
---|---
| | Click to discard any changes that you made in the text area and to re-synchronize the search clause with the search criteria in the grid. (Clicking this button again would restore your unsaved changes and disable the grid.)

**Note:** This button is available only after you begin making changes in the text area. Making any change in the search criteria grid disables this button.

7 When finished building the search clause, click **OK**.

---

**Related Information**

- “Overview of workspaces and perspectives” on page 15
- “Opening a workspace” on page 36
- “Creating an entirely new workspace” on page 32
- “Navigating to an object ” on page 53
- “Viewing related objects” on page 54

---

**Navigating through the DB2 catalog**

Use the following procedure to select an object, and then create new views of related DB2 objects. For example, you can select a table and then create an object view of its indexes or of the database that contains the table.

**To navigate through the DB2 catalog**

1. Select or create a DB2 object view that contains the object.
   
   For details, see “Creating a new DB2 object view” on page 45.

2. Navigate to and select your source object.
   
   For details, see “Navigating to an object ” on page 53.

3. From the **Navigate To** tool bar, click the required object button.

   Only object buttons related to the selected object are available.
Creating a DB2 statement cache view

You can create a view of DB2 statements from the statement cache. After you have created a DB2 statement cache view, you can select statements to view, Explain, and tune.

To create a DB2 statement cache view

1. Open or create a workspace.

2. In DB2 Navigator, select Add DB2 Statement Cache View.

   Tip
   You can also right-click in the DB2 navigation pane to select this.

3. Complete the Add DB2 Statement Cache View dialog box:
   a. Select a DB2 connection:
      - Type the full or partial name of a DB2 connection to select the first subsystem that matches this value in the list of favorite connections.
      - Use the menu arrow to select from your list of favorite connections.

   Note
   Click and specify which DB2 connections to include in your list of favorite connections.

   b. Enter a filter pattern for the selected program name or package name.

4. Click OK.

   The view is added into the DB2 navigation pane in a hierarchical display organized by subsystem and type.
5 (optional) To add additional filters to the same subsystem, return to Step 2 on page 50 and specify a filter.

Related Information

■ “Overview of workspaces and perspectives” on page 15
■ “Opening a workspace” on page 36
■ “Creating an entirely new workspace” on page 32
■ “Creating a new DB2 object view” on page 45
■ “Viewing related objects” on page 54
■ “Navigating through the DB2 catalog” on page 49
■ “Tuning SQL” on page 69
■ “Explaining SQL statements” on page 70

Removing a view

Use the following procedure to remove a DB2 statement cache view or DB2 object view.

To remove a view

1 Open the workspace containing the DB2 view.

2 From the DB2 navigation pane, select the DB2 view that you want to remove.

WARNING
The DB2 navigation pane displays the views in a hierarchy. When you select a subsystem or type node to delete, you select all the views of that node for deletion.

3 Click Remove View.

Tip
You can also right-click the Navigation pane and select the Remove View menu option.

4 When asked to confirm the deletion, click Yes.
Copying and pasting a view

Use the following procedures to copy and paste a DB2 statement cache view or DB2 object view.

To copy a view

1. Open the workspace containing the DB2 view.
2. From the DB2 navigation pane, select the DB2 view that you want to copy.
3. Right-click and click **Copy View**.
   
   You can now paste this view.

To paste a view

1. Open the workspace containing the DB2 view.
2. On the DB2 navigation pane, select and right-click where you want to paste a view.
3. Click **Paste View**.
   
   The Add Object View dialog box is displayed.
4. Edit the view settings.
   
   For more information, see “Creating a new DB2 object view” on page 45.

   **Note**

   By default, the value of the DB2 connection field is automatically updated to match the DB2 connection that it is pasted under.

5. Click **Ok**.

Browsing the catalog

You can browse the DB2 catalog, filter results, and view DB2 objects.

**Tip**

Click the column header to sort the contents of a table according to that column. Click again to toggle between ascending and descending order.
Navigating to an object

Use the following procedure to search DB2 catalogs and navigate to objects that you have selected.

**Note**
To navigate to a statement, see “Selecting a statement for SQL Analysis” on page 81.

**To navigate to an object**

1. Open a workspace. See “Opening a workspace” on page 36.

2. Use one of the following methods to navigate to the required object:
   - Add a DB2 object view containing the required object.
   - From the **Navigate To** toolbar, click an object icon to open a DB2 object view containing the required objects.
   - In a view, right-click an object row and select **Navigate To** and select the required object type.
   - In a view, click **Related Objects** to navigate to the required object type.

3. Select one or more objects from the object list.

**Where to go from here**

You can now view the object properties, view related objects, create a new DB2 object view using the selected object as a source, or perform commands on the selected object or objects.

**Related Information**

- "Viewing related objects" on page 54
- "Viewing object properties" on page 54
- "Navigating through the DB2 catalog" on page 49
- "Generating a command" on page 60
Viewing related objects

Use the following procedure to select an object and view lists of objects that are related to it. This creates a related objects view.

**To view related objects**

1. From the DB2 navigation pane, select a view containing the source object that interests you.

2. In the results pane, select the source object.

3. From the Commands toolbar, click **Related Objects**.

   **Tip**
   You can also right-click and select **View => Related Objects**.

   **Note**
   Only buttons for valid related objects are displayed.

4. From the Related Objects toolbar, click the button of the required object.

   A list of corresponding objects is displayed in the results pane.

   **Note**
   You can select an object from this list and use it as a source for navigation or to perform commands on it.

**Related Information**

- "Related Objects tab" on page 93

---

Viewing object properties

Use the following procedure to view the properties of any object in the catalog for which you have authorization.

**To view object properties**

1. Select or create a workspace that contains a DB2 object view containing the object.
Note
If required, you can add a new DB2 object view.

2 Navigate to the object.

3 Perform one of the following actions:

- In the Commands toolbar, click Properties.

- In the results list, select and double-click the object row.

- In the results list, select an object row, right-click and select View => Properties.

The properties box of the selected object is displayed.

4 Click OK to close the properties box.

Exporting data

Use the following procedure to export data in .csv format to the location of your choosing. The output includes the column headings.

To export data

1 Select or create a DB2 object view that contains the object or objects that you want to export.

   For details, see “Creating a new DB2 object view” on page 45.

2 Navigate to and select your source object or objects.

   For details, see “Navigating to an object” on page 53.

3 Perform one of the following tasks:

   - To export all rows in the view, right-click anywhere in the results pane and select Select All; then right-click again and select Export data.

   - To export a specific object, select one or more object entries, right-click and click Export Data.

4 When prompted, select a location for the exported data.
The default file name is `export_data.csv`.

5 Save the file.

**Related Information**

- “Copying data” on page 56

---

**Copying data**

Use the following procedure to copy data from the results pane to the clipboard.

**To copy data**

1 Select or create a DB2 object view that contains the object or objects that you want to export.

   For details, see “Creating a new DB2 object view” on page 45.

2 Navigate to and select your source object or objects.

   For details, see “Navigating to an object” on page 53.

3 Perform one of the following tasks:

   - To copy all rows in the view, right-click anywhere in the results pane and click **Select All**; then right-click and select **Copy**.

   - To copy a specific object, select one or more object entries; right-click, and click **Copy**.

You can now paste the data directly into a file or a spreadsheet application like Microsoft Excel. The data automatically contains the column names.

**Related Information**

- “Editing text files in Scratchpad” on page 61
- “Exporting data” on page 55
Setting DB2 Navigator options

Click DB2 Navigator Options to access and set DB2 Navigator options.

Table 4 on page 57 and Table 5 on page 57 show the options that you can set.

**Table 4: CATALOG MANAGER Options (HDDL and DDL only)**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal Point</td>
<td>Select the check box if you want to use a period (.) for decimal points. Clear this check box if you want to use a comma.</td>
<td>Selected (period)</td>
</tr>
<tr>
<td>Verbose Output</td>
<td>Select this check box to run the command with output level VERBOSE. Clear this check box to use output level TERSE.</td>
<td>Selected (VERBOSE output)</td>
</tr>
</tbody>
</table>

**Table 5: Object Types for HDDL**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object types</td>
<td>Select the objects that you want to include in the HDDL output. Clear the check box for any object that you want to omit.</td>
<td>All selected except Auths</td>
</tr>
<tr>
<td>Define (HDDL and DDL only)</td>
<td>Select the check box if you want to include the DEFINE parameter in DDL or HDDL for a table space or index. Clear the check box to omit the parameter.</td>
<td>Not selected</td>
</tr>
<tr>
<td>SQLID before Grant (DCL only)</td>
<td>Select to generate a SET CURRENT SQLID= grantor statement before each GRANT statement. This option is used for processing HDDL with AUTHs, HGRANT, and CASCADE REVOKE REASSIGN. Clear the check box to omit the statement.</td>
<td>Not selected</td>
</tr>
</tbody>
</table>
Working with commands

You can edit and run many common commands directly from BMC Workbench for DB2. You use the integrated Scratchpad editor that is a fully featured editing tool.

The workflow can include the following steps:

1. “Navigating to an object” on page 53
2. “Generating a command” on page 60
3. “Editing text files in Scratchpad” on page 61
4. “Running a command” on page 65

Supported commands

This topic describes the supported commands that you can edit and run directly from BMC Workbench for DB2.

**Note**
The HDDL command is available if you have a valid license for the BMC Object Administration for DB2 solution.

<table>
<thead>
<tr>
<th>Command</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DDL</td>
<td><img src="image" alt="ddl" /></td>
<td>Displays the DDL (Data Definition Language) for a selected object</td>
</tr>
<tr>
<td>HDDL</td>
<td><img src="image" alt="hddl" /></td>
<td>Displays the HDDL (Hierarchical Data Definition Language) for the selected object and its dependents</td>
</tr>
<tr>
<td>DCL</td>
<td><img src="image" alt="dcl" /></td>
<td>Displays the DCL (Data Control Language) for the selected object</td>
</tr>
<tr>
<td>DROP</td>
<td><img src="image" alt="drop" /></td>
<td>Displays the DROP command for the selected object</td>
</tr>
<tr>
<td>Command</td>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>BIND</td>
<td><img src="image" alt="Book" /></td>
<td>Displays the BIND command for the selected package, plan, or collection ID</td>
</tr>
<tr>
<td>REBIND</td>
<td><img src="image" alt="Book" /></td>
<td>Displays the REBIND command for the selected package, plan, or collection ID</td>
</tr>
<tr>
<td>FREE</td>
<td>![Stop]</td>
<td>Displays the FREE command for the selected package or plan</td>
</tr>
<tr>
<td>DISPLAY</td>
<td><img src="image" alt="Book" /></td>
<td>Displays the status of the selected object</td>
</tr>
<tr>
<td>START</td>
<td><img src="image" alt="Play" /></td>
<td>Displays the START command for a database, tablespace, table, index, view, or stored procedure</td>
</tr>
<tr>
<td>STOP</td>
<td>![Stop]</td>
<td>Displays the STOP command for a database, tablespace, table, index, view, or stored procedure</td>
</tr>
<tr>
<td>SELECT</td>
<td><img src="image" alt="File" /></td>
<td>Displays the SELECT command for a table, alias, or view.</td>
</tr>
<tr>
<td>INSERT</td>
<td><img src="image" alt="File" /></td>
<td>Displays the INSERT command for a table, alias, or view</td>
</tr>
<tr>
<td>UPDATE</td>
<td><img src="image" alt="File" /></td>
<td>Displays the UPDATE command for a table, alias, or view</td>
</tr>
<tr>
<td>DELETE</td>
<td><img src="image" alt="File" /></td>
<td>Displays the DELETE command for a table, alias, or view</td>
</tr>
</tbody>
</table>

### Generating a command

Use the following procedure to generate a command for a selected object. The generated statement for the selected object is displayed in Scratchpad.

For more information, view the Quick Course "Workbench for DB2 - Generating DML."

**To generate commands**

1. In the DB2 Navigator perspective, select the required object or objects (you can select up to five objects).

   For more information, see “Navigating to an object” on page 53.

   In the command tool bar, valid command buttons for the selected object are displayed. See “Supported commands” on page 59.
2 Click the required command button.

The Scratchpad perspective is opened, and the SQL statement is displayed in the Command Text tab of the Scratchpad. If you have selected more than one object, the SQL statements or commands are displayed consecutively in the Scratchpad.

3 You can now edit the SQL statement or command.

For more information, see “Editing text files in Scratchpad” on page 61.

Related Information

■ “Supported commands” on page 59

Editing text files in Scratchpad

Use the following procedure to edit any text file that is opened in Scratchpad.

Scratchpad is automatically opened to edit files when you perform the following tasks:

■ Add a new file view to edit a new command

■ Open an existing file displayed under Files in the Scratchpad perspective

■ Select an object or group of objects in the DB2 navigation perspective and click one of the command options such as DDL

■ Double-click a data set in the File Locator

Note
To remove a file view from the Scratchpad navigator pane, select the file view and click Remove File View.

To edit a file

1 Perform one of the following actions:
- Open Scratchpad perspective and select an existing view for editing.
- Edit the command that was automatically opened in Scratchpad.
- Add a new file view, then write or copy and paste a command into Scratchpad.

2. In the Command Text tab, edit the command using the following editing options:

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find a search string</td>
<td>Enter the search string in the <strong>Search</strong> box and click <strong>Find</strong>.</td>
</tr>
<tr>
<td>Find and replace a search string</td>
<td>1 Enter the element in the <strong>Search</strong> box.</td>
</tr>
<tr>
<td></td>
<td>2 Enter the replacement string in the <strong>Replace</strong> box.</td>
</tr>
<tr>
<td></td>
<td>3 Click <strong>Find</strong>.</td>
</tr>
<tr>
<td></td>
<td>4 Click <strong>Replace</strong>.</td>
</tr>
<tr>
<td>Search and replace all instances of the search</td>
<td>1 Enter the search string in the <strong>Search</strong> box.</td>
</tr>
<tr>
<td>string</td>
<td>2 Enter the replacement string in the <strong>Replace</strong> box.</td>
</tr>
<tr>
<td></td>
<td>3 Enable the <strong>All</strong> checkbox.</td>
</tr>
<tr>
<td></td>
<td>4 Click <strong>Replace</strong>.</td>
</tr>
<tr>
<td>Make the search case sensitive</td>
<td>Enable the <strong>A/a</strong> checkbox.</td>
</tr>
<tr>
<td>Undo an action</td>
<td>Click 🔄 to undo the last action.</td>
</tr>
<tr>
<td>Redo an action</td>
<td>Click 🔄 to cancel the last undone action.</td>
</tr>
<tr>
<td>Enable the editor to accept Regular expressions</td>
<td>Select the <strong>RegEx</strong> checkbox.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Scratchpad supports all standard Regular expressions.</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Copy an existing file| 1. Browse to a data set and open an existing file.  
|                      | 2. Click **Copy File**.  
|                      | 3. Save the file. Follow the instructions in Step 4 on page 63.                                                                          |

3. Save the scratchpad contents:

- From the toolbar, click **Save File** to save the active edited command output.

- If there are more than one open scratchpad files (for example you selected and created the DDL of several objects simultaneously), click **Save all files** (in the Navigation pane) to open a Save dialog box for each file.

  **Note**
  For each file, you can save to a separate data set or select **Don't Save**.

All files that are saved to the mainframe are automatically displayed in the Scratchpad navigation pane under Files.

4. Select a data set on the IBM z/OS system in which to save the file.

   a. Click **Add Data Set Filter**.

   b. In the Filter Pattern box, enter a filter (the wildcard * is supported) to list the data set where you want to save the file.

      A hierarchical tree of matching data sets is displayed.

   c. Select the required data set.

      If the data set has been archived, you are asked if you want to restore it.

5. Enter a file name.

6. Click **OK**.

All files that are saved to the mainframe are automatically displayed in the Scratchpad navigation pane under Files.
Creating commands

Use the following procedure to edit a command that you write or paste into Scratchpad.

All files containing commands can be saved to the mainframe and are displayed in the Scratchpad navigation pane under Files.

To create a new command

1. Click the Scratchpad perspective tab.

2. Click Add File View.

   A new file view is created and displayed in the Scratchpad navigation pane. In the Command Text tab, an empty scratchpad is displayed and ready for use.

3. Write or paste the command into the empty scratchpad.

4. Edit the command.

   For more information, see “Editing text files in Scratchpad” on page 61.

5. Run the command.

   For more information, see “Running a command” on page 65.

Related Information

- “Supported commands” on page 59
Running a command

Use the following procedure to run one or more commands directly from the Scratchpad. If there are multiple commands displayed in the Scratchpad, you can run all of them or select and run a single command.

Error messages can be displayed if the code fails to successfully run.

To run a command

1. Enter the command or commands into the Scratchpad screen.

   The source can be either:
   - A command that you pasted or typed into the Scratchpad screen and then edited.
     For more information, see “Creating commands” on page 64.
   - Command or commands that you have generated from DB2 objects.
     For more information, see “Generating a command” on page 60.

2. Perform one of the following tasks:

   - To run one command from a group displayed in the Scratchpad, select one command and click Run Selected.

   - To run all commands displayed in the Scratchpad, click Run.

   **Note**
   Any existing output is discarded when you run the commands again.

3. Select the DB2 subsystem to run the command:

   - By default the last-executed DB2 connection is pre-selected.

   - Type the full or partial name of a DB2 connection to select the first subsystem that matches this value in the list of favorite connections.

   - Use the menu arrow to select from your list of favorite connections.
Click and specify which DB2 connections to include in your list of favorite connections.

The status bar at the bottom of the screen indicates whether the command runs successfully.

The Output tab opens displaying a summary for each command that you ran.

4 In case of failure, perform one of the following tasks:

- To view all the error messages, click View Messages.

- To view error messages for a specific command, on the Output tab, click .

Note: View All Result Sets and View Output Text are enabled only when the Output tab is active.

5 To view results, perform one of the following tasks:

- To view all the results, click View All Result Sets.

- To view the result set for a specific command, on the Output tab, click the relevant View Result Set.

One or more Result Set tabs are opened.

6 To save results as a text file on your local file system:

a Click the Output tab and in the tool bar, click View Output Text.

b Click .

Related Information

- "Supported commands" on page 59
### Setting Scratchpad options

You can use the **Scratchpad Options** button 🔄 to set optional behavior of the Scratchpad.

The following options are available:

<table>
<thead>
<tr>
<th>Option Title</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drop Recovery</td>
<td>Enable <strong>Drop Recovery</strong> so that dropped objects can be restored from CATALOG MANAGER using the Drop Recovery command.</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Drop Recovery option is available only if you have a valid license for the BMC Object Administration for DB2 solution.</td>
<td></td>
</tr>
<tr>
<td>Select Options</td>
<td>You can set the maximum values for the execution of SELECT statements (default values in parentheses):</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>- Maximum numeric length (10)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Maximum CHAR length (64)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Maximum VARCHAR length (64)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Maximum select rows (300)</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Tip:</strong> 0 returns all rows in the result set</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The total amount of returned data in the result set cannot exceed 50 MB, this limit is unaffected by the values of the Select Options. A message is displayed when this limit is reached.</td>
<td></td>
</tr>
</tbody>
</table>

---

**Related Information**

- “Supported commands” on page 59
Tuning SQL

You can create one or more What-If statements and use them to progressively tune a selected baseline statement.

By default, BMC Workbench for DB2 honors the DB2 privileges to generate Explain plans. To configure BMC Workbench to use Install SYSADM for executing Explains, see information about the authexpl option in the BMC Products and Solutions for DB2 Configuration Guide.

Tuning SQL workflow

The workflow of tuning a SQL statement typically includes the following steps:

To tune a SQL statement

1. Select a SQL statement to be used as the baseline statement.
   For more information, see “Selecting a statement for SQL Analysis” on page 81.

2. Perform an Explain on the statement.
   For more information, see “Explaining SQL statements” on page 70.

3. Create a What-If scenario based on the baseline statement.
   For more information, see “Creating a What-If scenario” on page 72.

4. Compare the cost of the statements.
   For more information, see “Comparing statements” on page 80.

5. Create a new What-If scenario.

6. Continue the process until you have optimized the statement.
Explaining SQL statements

The Explain command explains the steps that the DB2 optimizer must take to execute the selected SQL statement.

SQL Explain displays the cost for each step of the SQL statement and the total cost of the entire statement. This data enables you to determine which part of the statement is estimated to consume the most resources.

An Explain takes one of the following forms:

- A dynamic Explain that asks the DB2 optimizer for an explanation of the access path. This process evaluates access paths, SQL text, and key catalog statistics in real time.

- A static Explain from a bind with EXPLAIN(YES). This process reports the access path information that was derived when you performed a bind with EXPLAIN(YES).

- An Explain Statement Cache on a dynamic SQL statement. This process performs an EXPLAIN STMTCACHE STMTID on a dynamic SQL statement that was executed and is still in the Statement Cache. The access path used at the time that the statement was executed is retrieved from the statement cache and reported on.

- An Explain Package, in which the current access path for a static SQL statement is retrieved and reported on even if a BIND with EXPLAIN(YES) was not previously performed.

Note

By default, BMC Workbench for DB2 honors the DB2 privileges to generate Explain plans. To configure BMC Workbench to use Install SYSADM for executing Explains, see information about the authexpl option in the BMC Products and Solutions for DB2 Configuration Guide.

The Explain plan shown is the hierarchical representation of rows extracted from the DB2 plan table.

To Explain a SQL statement

1. Select a SQL statement to be used as the baseline statement.
Perform one of the following tasks:

- “Selecting a statement from the DB2 statement cache” on page 82
- “Selecting a statement from a package” on page 83
- “Selecting an ad hoc statement” on page 84

The SQL Tuning perspective is displayed, and the SQL statement is displayed in the SQL tab. The statement and parameters are also displayed. For more details, see “Explain tab” on page 90.

2

Click Generate explain plan.

The Explain results are displayed. The following tabs are also displayed:

- SQL (see “SQL tab” on page 88)
- Indexes (see Indexes tab on page 88)
- Explain (see “Explain tab” on page 90)
- Cost (see “Cost tab” on page 92)
- Predicates (see “Predicates tab” on page 92)
- Compare (see “Compare tab” on page 93)

**Note**

The Compare tab is dimmed until you generate the first What-If scenario.

- Catalog Objects (see “Related Objects tab” on page 93)

---

**What-If scenarios**

The What-If scenarios enable you to edit a statement, add or drop indexes, execute Explain, and compare the results of the statement to another statement.
Creating a What-If scenario

Use the following procedure to create one or more What-If scenarios from a source statement and then use them to compare Explain results.

**To create a What-If scenario**

1. In the SQL Tuning perspective, select the source statement.

   You can use a baseline statement (identified by ![flag]) or one of the What-If scenarios that you have previously created (identified by ![flag]).

   The SQL tab displays the details of the source SQL statement.

2. Click ![flag].

3. *(optional)* On the SQL tab, enter a unique name for the What-If scenario.

   If you do not give the scenario a new name, by default an incremental number is added as a suffix to the source statement name.

   a. Edit the details of the scenario.

      You can change the DB2 connection, table qualifier, Explain type and degree.

      Click ![flag] and specify which DB2 connections to include in your list of favorite connections.

   b. Edit the SQL statement.

4. *(optional)* On the Indexes tab, modify the indexes.

   For more information, see “Creating and editing a What-If index scenario” on page 73.

5. When you have finished editing, click ![flag].

**Where to go from here**

You can now compare this What-If scenario with another scenario or baseline statement.
Creating and editing a What-If index scenario

You can evaluate the effect on the statement performance by adding or dropping an index, or by updating the index statistics.

Before you begin

The What-If index feature is available only if you have a valid license for the BMC Performance for DB2SQL solution.

To create a What-If index

1 In the SQL Tuning perspective, select the source statement.

   You can use a baseline statement (identified by ) or one of the What-If scenarios that you have previously created (identified by ).

   The SQL tab displays the details of the source SQL statement.

2 If the selected statement has not been explained, click to Explain it.

3 Click What-If.

4 (optional) Enter a unique name for the new scenario.

   **Note**

   If you do not enter a name, the scenario uses the source statement's name with an incremental number added as a suffix.

5 Click the Indexes tab.
Note
For more information, see “Indexes tab” on page 88. The Indexes tab is available only if the baseline statement was successfully explained.

The Indexes tab includes these items:

- Command buttons that enable you to add, drop, edit, or copy indexes from the What-If statements.
- The **Tables pane** lists all tables that are referenced in the SQL statement.
- The **Indexes pane** lists the indexes of the selected table (initially the top entry in the list).

Note
✓ indicates indexes that the Explain plan uses.

6 From the Tables pane, select the table that contains the index that you want to edit.

7 From the Indexes pane, select the index.

Perform any of the following actions to set up the scenario that you want to evaluate:

- Add a new index for the selected table (as explained in “Adding an index to a What-If scenario” on page 75).
- Copy an existing index and modify the copy (“Copying an index for a What-If scenario” on page 77).
- Edit an existing index (“Editing an index for a What-if scenario” on page 78).
- Drop an index (“Dropping an index from a What-If scenario” on page 77).
- Revert any changes made to the catalog, by clicking Revert.
- Generate statements to reflect changes for this What-If index scenario.
  For more information, see “Generating a tuned statement” on page 79.

Note
You cannot make changes to the baseline statement.

8 Click to explain the edited What-If scenario.
You cannot edit the What-If scenario after it is explained.

9 Compare the resulting scenario with the baseline or with another What-If scenario as explained in “Comparing statements” on page 80.

10 Continue from Step 7 on page 74 until you have fully tuned the statement.

11 If you want to generate the tuned statement, click Generate to copy the DDL.

For more information, see “Generating a tuned statement” on page 79.

Related Information

■ “Working with commands” on page 59

Adding an index to a What-If scenario

Use the following procedure to add a What-If index to a selected table and evaluate how the change would affect the SQL statement's performance.

Note

You cannot add an index to the baseline statement (identified by ).

To add a new index

1 Select the table as described in “Creating a What-If scenario” on page 72.

2 Click Add.

3 In the Index Attributes dialog box, define the new index:

   a At Index name, enter the name that you want to use.

   b At Unique rule accept the default (Duplicate) or select Unique or Unique unless Null.

   c Select the corresponding check boxes, if you want the index to be clustering, partitioned, or padded.

   d Click Next.

4 In the Key Columns dialog box, define the key columns for the index:
a Add columns or remove available columns from the Selected Columns pane.

b If you want to reorder a column, select it and use the Up or Down button to change the column’s position.

c Click the arrow that indicates to sort the columns in ascending, descending, or random order.

d Click Next.

5 In the Index Statistics dialog box, define the statistics for this index.

a At First key cardinality, enter a positive integer (default 0) or -1 (indicating that no statistics have been gathered).

b At Full key cardinality, enter a positive integer (default 0) or -1 (indicating that no statistics have been gathered).

c At Cluster ratio, enter a number between 0 and 1 (default 0.8) or -2 (indicating that no statistics have been gathered).

d At Leaf pages, enter a positive integer or -1 (indicating that no statistics have been gathered, default -1).

e At Number of Levels, enter the number of required levels (default -1).

f Click Finish.

The wizard closes, and the results pane shows the new index with a + beside it.

Where to go from here

You can now Explain and compare the new scenario.

Related Information

■ “Comparing statements” on page 80
■ “Indexes tab” on page 88
■ “Explaining SQL statements” on page 70
Dropping an index from a What-If scenario

Use the following procedure to evaluate how dropping an index would affect the performance of a SQL statement.

**Note**

You cannot add an index to the baseline statement (identified by ![index symbol]).

To drop an index

1. Create a What-If scenario and select an index.
   For more information, see “Creating a What-If scenario” on page 72.

2. Click **Drop**.
   
   The **Indexes** pane displays ![index symbol] next to a dropped index.

3. Click ![explain symbol] to Explain the statement.

4. *(optional)* Select an index and click **Revert** to return indexes that you have dropped.

Where to go from here

Explain and compare the scenario after you have completed all your editing.

**Related Information**

- “Comparing statements” on page 80
- “Indexes tab” on page 88
- “Explaining SQL statements” on page 70

Copying an index for a What-If scenario

Use the following procedure to copy an index, edit it, and save it as a What-If index in a What-If scenario.
Note

You cannot add an index to the baseline statement (identified by  ).

To copy an index

1. Create a What-If scenario and select an index.
   
   For more information, see “Creating a What-If scenario” on page 72.

2. Click Copy.

3. In the Index Attributes dialog box, change the name and edit any other index attributes.
   
   For more information, see “Adding an index to a What-If scenario” on page 75.

4. Click Finish.

   The wizard closes, and the results pane shows the new index with  beside it.

Where to go from here

You can now Explain and compare the scenario after you have completed all your editing.

Related Information

- “Comparing statements” on page 80
- “Indexes tab” on page 88
- “Explaining SQL statements” on page 70

Editing an index for a What-if scenario

Use the following procedure to edit an index and evaluate the effect on the SQL statement's performance.
Note
You cannot edit the columns of an index in the baseline statement
(indicated by ), but you can make changes to the index attributes and statistics.

To edit an index

1 Select an index.
   For more information, see “Adding an index to a What-If scenario” on page 75.

2 Click Edit.

3 Complete the Index Attributes dialog box.
   For more information, see “Adding an index to a What-If scenario” on page 75.

Where to go from here

Explain and compare the statement after you have completed all your editing.

Related Information

- “Comparing statements” on page 80
- “Indexes tab” on page 88
- “Explaining SQL statements” on page 70

Generating a tuned statement

After you have evaluated the effects of What-If indexes on statement performance,
you can generate the SQL statements required to create indexes, drop indexes, and
update index statistics.

To generate a tuned statement

1 Create a What-If scenario.
   For more information, see “Creating and editing a What-If index scenario” on page 73.
2 Use the commands to make changes to the indexes.

For more information, see:

■ “Adding an index to a What-If scenario” on page 75
■ “Dropping an index from a What-If scenario” on page 77
■ “Editing an index for a What-if scenario” on page 78
■ “Copying an index for a What-If scenario” on page 77

3 Explain the What-If scenario.

For more information, see “Explaining SQL statements” on page 70.

4 Click Generate.

The Generated Statements pane displays the statement required to make the index changes.

5 Click Save.

6 Save the file to the required data set.

For more information, see “Editing text files in Scratchpad” on page 61.

Comparing statements

Use the following procedure to compare Explain results within the same tuning session.

Before you begin

Create one or more What-If statements, as instructed in “Creating a What-If scenario” on page 72.

Note

The Compare tab is not available until you create at least one What-If scenario.

To compare statements

1 In the SQL Tuning perspective, open the Compare tab.
2. From the tuning session pane, in the comparison pane on the left, select the first statement for comparison.

*Note*

The first statement is always displayed in the comparison panel on the left. The tabs in the SQL Tuning perspective always display information regarding the first statement.

3. From the list in the comparison pane on the right, select a second statement for comparison.

4. Click any step node of the Explain tree to compare the attributes of the selected node.

The results are displayed in the results pane. The results pane shows the detail information for the selected nodes in the trees.

Explain trees of both statements are displayed side-by-side, and in the results pane, a table compares attributes of the two statements. In each row, the first column displays the attribute name, the second column displays the value of the node in the first statement (left tree), and the third column shows the value of the second statement (right tree).

*Note*

 отметить, что атрибут имеет различные значения в двух сравниваемых заявлениях.

**Related Information**

- "Compare tab" on page 93

**Selecting a statement for SQL Analysis**

You can perform SQL analysis on an ad hoc statement, a statement selected from a DB2 package, or a statement selected from the DB2 statement cache.

**To select a statement**

1. Perform one of the following tasks:

   - “Selecting a statement from the DB2 statement cache” on page 82
   - “Selecting a statement from a package” on page 83
Selecting a statement from the DB2 statement cache

Use the following procedure to select and tune any DB2 statement in the DB2 statement cache. You must ensure that the workspace contains a DB2 object view that contains the statement.

To select a statement from the DB2 statement cache

1. Click the DB2 Navigator tab.
2. Click Add DB2 statement cache view.
   The DB2 Statement Cache for Program Filter dialog box is displayed.
3. Select a DB2 subsystem:
   - Type the full or partial name of a DB2 connection to select the first subsystem that matches this value in the list of favorite connections.
   - Use the menu arrow to select from your list of favorite connections.

   **Note**
   Click and specify which DB2 connections to include in your list of favorite connections.
4. In the filter box, enter the name of the program that contains the statement.
   You can use wildcards to return a list of statements contained by programs that match the pattern.
5. Click OK.
   In the results pane, a list of statements is displayed.

   **Note**
   Click the column headers to sort the results.
6. Select the desired statement and click Explain.
The SQL Tuning perspective is opened, and the graphical Explain for the selected statement is displayed in the Explain screen.

**Related Information**

- “Selecting a statement for SQL Analysis” on page 81

---

**Selecting a statement from a package**

Use the following procedure to select a statement from any package.

**To select a statement from a package**

1. Click the DB2 Navigator tab.
2. Open or create a package view that contains the required statement.
3. Select the package containing the required statement.
4. From the command tool bar, click **Show Explainable Statements**.
   
   All Explainable statements for that package are displayed in the results pane.
5. Search for and select the required statement.
6. Perform one of the following actions:
   - Click **Properties** to view the statement properties.
   - Click **Explain** to display the graphical Explain of the selected statement in the Explain tab. You can now perform SQL tuning tasks.

**Where to go from here**

You can return to the results pane in the DB2 Navigator tab to select other statements.
Related Information

- "Selecting a statement for SQL Analysis" on page 81

Selecting an ad hoc statement

Use the following procedure to browse and copy a statement stored in a data set or alternatively write a statement into the statement box of the SQL Tuning perspective.

**Note**
You can set values that are persistent for all ad hoc statements that you create in the current session in the current workspace. For details, see “Setting SQL tuning options” on page 95.

**To select an ad hoc statement**

1. Click the SQL Tuning perspective .

2. Click Add SQL Statement .

3. Complete the SQL tab:
   a. Enter a name for the statement.
   b. Perform one of the following tasks:
      c. Select a DB2 subsystem.
         - Type the full or partial name of a DB2 connection to select the first subsystem that matches this value in the list of favorite connections.
         - Use the menu arrow to display a list of connected subsystems.
      d. (optional) Enter the table qualifier.
         
         BMC Workbench for DB2 uses this qualifier if the table in the SQL is unqualified.
For the **Explain Type**, select **Dynamic**.

Select the **Degree** (degree of parallel processing to allow):

- Select **Any** to allow parallel processing.
- Select **1** to prohibit parallel processing.

Type or paste the SQL statement into the SQL statement box.

4. Click **Generate explain plan**.

The graphical Explain diagram of the SQL statement is displayed. If the statement is invalid you receive an error message.

**Related Information**

- "Selecting a statement for SQL Analysis” on page 81

---

**SQL Tuning perspective**

The commands in the SQL Tuning perspective enable you to analyze SQL statements and perform What-If comparisons.

After you have selected a SQL statement for analysis (see “Selecting a statement for SQL Analysis” on page 81), the SQL Tuning perspective is displayed.

The SQL Tuning perspective provides access to the result view tabs, which enable you to perform the tuning process. Depending on the activities being performed, the following tabs can be displayed:

- **SQL tab**
- **Indexes tab**
- **Explain tab**
- **Cost tab**
- **Predicates tab**
- **Compare tab** (shown in Figure 2 on page 86)
- **Related Objects tab**
Output tab

Figure 2: SQL Tuning perspective (Compare tab displayed)

Legend

<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Tuning session pane</td>
</tr>
<tr>
<td>2</td>
<td>Buttons for adding + and removing − SQL statements</td>
</tr>
</tbody>
</table>
| 3 | Active workspace name  
   An asterisk (*) indicates that the workspace has unsaved changes. |
| 4 | Perspective tabs  
The SQL Tuning tab is blue, indicating that it is the active tab. |
| 5 | Generate Explain plan button  
The button is dimmed after the statement is successfully explained. |
<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
</tr>
</thead>
</table>
| 6 | **What-If button**  
The What-If button is disabled (dimmed) on a selected statement if the statement has not been successfully explained. Unless the statement is successfully explained, you cannot create a What-If scenario based on that statement. |
| 7 | **Run button** |
| 8 | Name and ID of the active statement |
| 9 | *(Compare tab only)* Explain tree of the first statement  
**Note:** 🌟 indicates that at least one attribute of an object has different values in the two statements being compared. |
| 10 | Result view tabs show the result of explaining a statement, compare, and catalog objects which help you in the tuning process |
| 11 | *(Compare tab only)* Explain tree of the second statement |
| 12 | Explain timestamp and DB2 subsystem name |
| 13 | **Options button** 🌻 |
| 14 | *(Compare tab only)* Attribute details of second statement |
| 15 | *(Compare tab only)* Attribute details of first statement |
| 16 | *(Compare tab only)* Attribute names  
**Note:** 🌟 indicates that the attribute has different values in the two statements being compared. |

---

**Related Information**

- “SQL tab” on page 88
- “Indexes tab” on page 88
- “Explain tab” on page 90
- “Cost tab” on page 92
- “Predicates tab” on page 92
- “Related Objects tab” on page 93
- “Output tab” on page 95
**SQL tab**

The SQL tab is opened after you select a statement for Explain in the DB2 Navigator perspective, or when you create a tuning session for an ad hoc SQL statement.

If you select a statement from a package or from the statement cache, the statement is displayed in the SQL tab.

---

**Tip**

If you want to edit a statement selected from the statement cache or from a package, you must create a What-If scenario.

---

If you are creating an ad hoc tuning session, you must enter the statement into this pane. You must also populate the dialog box. For more information, see “Selecting an ad hoc statement” on page 84.

---

**Note**

After the statement has been explained, click What-If to modify the statement, or enter new parameters to run a subsequent Explain.

---

**Related Information**

- “SQL Tuning perspective” on page 85

---

**Indexes tab**

The Indexes tab lists indexes for all the tables participating in the Explain plan. The tab is displayed only after the baseline statement is Explained.

**Buttons on the Indexes tab**

The following buttons are available:

<table>
<thead>
<tr>
<th>Button</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Adds an index to a What-If scenario</td>
</tr>
<tr>
<td>Copy</td>
<td>Build a copy of an existing index</td>
</tr>
</tbody>
</table>
### Button | Details
---|---
**Edit** | Edits the attributes of an index
  - For an existing index, you can only edit the statistics.
  - For an added or copied index, you can edit all fields.

**Drop** | Drops an index

**Revert** | Reverts changes made for the selected index
  - If the selected index was added, the index is dropped.
  - If the selected index was dropped, the index is returned.

**Generate** | Generates statements reflecting changes that you have made to a What-If scenario
This command button is dimmed unless you have made changes to the SQL statement.

---

**Note**
The command buttons are available only:

- For What-If scenarios
  You can only update the statistics for existing indexes, though you can copy indexes from existing indexes.

- For unexplained statements
  After you have Explained a statement, the command buttons are dimmed.

- If you have a license for BMC Performance *for DB2 SQL*.

### Panes
The Indexes tab has a **Tables** pane and an **Indexes** pane:

- The **Tables** pane lists all tables that are referenced in the SQL statement.

- The **Indexes** pane lists the indexes of the selected table (by default, the table shown at the top of the **Tables** pane).
Note

✔ indicates an index that participates in the Explain plan.

🚫 indicates an index that has been dropped.

➕ indicates an index that has been added.

胚 indicates an index that has been edited

Related Information

- “SQL Tuning perspective ” on page 85

Explain tab

The Explain tab displays a visual representation of the DB2 Explain plan.

The DB2 statement can be viewed in the format of an Explain diagram (default) or an Explain tree:

- The Explain diagram displays each step as a node. Each node shows the cost of the step and the following icons:
  - An icon indicating the step type. These icons can be displayed:
    - Operator
    - Query block
    - Table
    - Index
  - An icon indicating the highest severity of the message rules associated with that step (if a message rule exists). These icons can be displayed:
    - Severe
To focus on specific steps, you can move the nodes around the screen and zoom in and out.

- The Explain tree lets you expand or hide steps in order to focus on specific steps.

Graphical Explain enables you to perform the following tasks:

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View step details</td>
<td>1   Perform one of the following actions:</td>
</tr>
<tr>
<td></td>
<td>■ In the Explain diagram, click the linked step name of a node.</td>
</tr>
<tr>
<td></td>
<td>■ In the Explain tree, click the node.</td>
</tr>
<tr>
<td></td>
<td>2   In the Explain Detail property box, select the Step Details tab to view the step information from the plan table.</td>
</tr>
<tr>
<td>View message rules</td>
<td>1   Perform one of the following actions:</td>
</tr>
<tr>
<td></td>
<td>■ In the Explain diagram, click the linked step name of a node.</td>
</tr>
<tr>
<td></td>
<td>■ In the Explain tree, click the node.</td>
</tr>
<tr>
<td></td>
<td>2   In the Explain Detail property box, select the message rules tab to view the message rules (those delivered by BMC and user-defined message rules).</td>
</tr>
<tr>
<td>Toggle between the Explain diagram and Explain tree formats</td>
<td>Click the Explain Display toggle.</td>
</tr>
<tr>
<td>Move the node</td>
<td>Click and hold down the step node and move the mouse.</td>
</tr>
<tr>
<td>Zoom in and out</td>
<td>On the Zoom slider, hold down and move the mouse or repeatedly click <strong>Zoom in</strong> or <strong>Zoom out</strong>.</td>
</tr>
<tr>
<td></td>
<td>To change the section of the Explain diagram displayed, hold down and move the mouse.</td>
</tr>
<tr>
<td>Move a node in the diagram to the top of the screen</td>
<td>To move a node in a diagram to the top of the screen, double-click the node.</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Reset Diagram</strong> to revert to the initial state of the graph.</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Revert the positioning of the Explain diagram to the initial positions</td>
<td>Click <strong>Reset Diagram</strong>.</td>
</tr>
<tr>
<td>Expand or hide steps in the Explain tree</td>
<td>Click the expansion arrow next to the step node.</td>
</tr>
</tbody>
</table>

**Related Information**

- “SQL Tuning perspective” on page 85

## Cost tab

The Cost tab displays the total cost of the Explain plan and other details about the Explain plan.

The results pane is divided into two panes:

- The upper pane displays the cost and other details that are extracted from the DB2 plan table.

- The lower pane lists BMC generated message rules and any user-defined message rules.

  The associated icon identifies the rule as **Severe**, **Warning**, or **Informational**.

**Related Information**

- “SQL Tuning perspective” on page 85

## Predicates tab

The Predicates tab displays the filter factors and indexability of each predicate.

The predicates are listed in a table in the order in which they are extracted from the Explain plan tables.
Related Information

- “SQL Tuning perspective” on page 85

Compare tab

The Compare tab displays side-by-side Explain trees representing two statements that are being compared.

You can create a What-If scenario and compare it to the source statement or to another What-If scenario. For more information, see “Comparing statements” on page 80.

Note
The Compare tab is available only if the tuning session contains two or more statements.

See “SQL Tuning perspective” on page 85 for an example of the Compare tab.

Related Objects tab

The Related Objects tab enables you to view objects related to the tables that are referenced in the statement.

The Related Objects tab contains two panes:

- The Tables pane lists all of the tables referenced in the SQL statement.
- The Related Objects pane contains the Related Objects toolbar and a results table. The results table lists all of the related objects of the selected object type.

You can perform the following tasks:

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a table</td>
<td>On the Tables pane, select the required table. When you change the selected table, the results table is updated.</td>
</tr>
</tbody>
</table>
Task | Description
--- | ---
Select a related object | From the Related Objects toolbar, click an object type button. The results table is populated with all objects of this type that are related to the selected table. 
**Note:** You are notified if no related objects of that type exist.

Table 7: Object type buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Aliases" /></td>
<td>Aliases</td>
</tr>
<tr>
<td><img src="image" alt="Data Types" /></td>
<td>Data Types</td>
</tr>
<tr>
<td><img src="image" alt="Databases" /></td>
<td>Databases</td>
</tr>
<tr>
<td><img src="image" alt="Data sets" /></td>
<td>Data sets</td>
</tr>
<tr>
<td><img src="image" alt="Key Columns" /></td>
<td>Key Columns</td>
</tr>
<tr>
<td><img src="image" alt="Image Copy" /></td>
<td>Image Copy</td>
</tr>
<tr>
<td><img src="image" alt="Indexes" /></td>
<td>Indexes</td>
</tr>
<tr>
<td><img src="image" alt="Packages" /></td>
<td>Packages</td>
</tr>
<tr>
<td><img src="image" alt="Plans" /></td>
<td>Plans</td>
</tr>
<tr>
<td><img src="image" alt="Procedures" /></td>
<td>Procedures</td>
</tr>
<tr>
<td><img src="image" alt="Sequences" /></td>
<td>Sequences</td>
</tr>
<tr>
<td><img src="image" alt="Storage Groups" /></td>
<td>Storage Groups</td>
</tr>
<tr>
<td><img src="image" alt="Synonyms" /></td>
<td>Synonyms</td>
</tr>
<tr>
<td><img src="image" alt="Tables" /></td>
<td>Tables</td>
</tr>
</tbody>
</table>
### Output tab

The Output tab displays the results of an executed SQL statement. The Output tab is displayed when you click Run in the SQL Tuning perspective.

**Note**

The Run button is dimmed and unavailable when the Output tab is selected.

---

#### Related Information

- “SQL Tuning perspective” on page 85

---

### Setting SQL tuning options

You can use the Options button to set optional behavior of the SQL Tuning perspective.

Two tabs are displayed:
“Tuning tab” on page 96 sets the options for defining SQL tuning settings for the current session.

“Execution tab” on page 97 sets the options for executing SELECT statements.

**Tuning tab**

**Table 8: Dynamic SQL Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plan Table Owner</td>
<td>Specifies the name of the owner for the DB2 plan table used</td>
<td>BMC</td>
</tr>
<tr>
<td></td>
<td>Note: If you want the owner to use lowercase characters, verify that you</td>
<td></td>
</tr>
<tr>
<td></td>
<td>have not enabled <strong>Convert filter values to upper case</strong>. See “Setting</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>BMC Workbench options</strong>” on page 29.</td>
<td></td>
</tr>
</tbody>
</table>

**Table 9: Ad Hoc SQL Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Qualifier</td>
<td>Specifies a table qualifier to qualify DB2 objects that are not qualified in</td>
<td>No default</td>
</tr>
<tr>
<td></td>
<td>the SQL statement</td>
<td>value</td>
</tr>
<tr>
<td>Degree</td>
<td>Specifies whether to consider parallel processing during an Explain:</td>
<td>Default = Any</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Any</strong> considers parallel processing.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ <strong>1</strong> does not consider parallel processing</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Blank uses the value at bind time</td>
<td></td>
</tr>
</tbody>
</table>

**Table 10: General Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule set</td>
<td>Defines the message rules:</td>
<td>DEFAULT</td>
</tr>
<tr>
<td></td>
<td>■ <strong>DEFAULT</strong> displays all rules that are related to performance issues</td>
<td></td>
</tr>
<tr>
<td></td>
<td>and are primarily relevant to DBAs.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ <strong>APPDEV</strong> displays rules that are primarily relevant to application</td>
<td></td>
</tr>
<tr>
<td></td>
<td>developers.</td>
<td></td>
</tr>
</tbody>
</table>
### Option

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default values</th>
</tr>
</thead>
</table>
| Online Application | Specifies whether to trigger specific rules for tablespace scan, list and sequential prefetch, and multiple index access paths (MIAP) considerations:  
  ■ Select to trigger the rules.  
  ■ Clear to not trigger the rules. | Unchecked |
| Cost Translation Rate per Timeron | Specifies the rate used to translate the timeron cost into a monetary unit | 1.0 |
| Cost Translation Rate per Service Unit | Specifies the rate used to translate the service unit cost into a monetary unit | 1.0 |

### Execution tab

**Table 11: Select options**

<table>
<thead>
<tr>
<th>Option Title</th>
<th>Description</th>
<th>Default values</th>
</tr>
</thead>
</table>
| Select Options | You can set the maximum values for the execution of SELECT statements (default values in parentheses):  
  ■ Maximum numeric length (10)  
  ■ Maximum CHAR length (64)  
  ■ Maximum VARCHAR length (64)  
  ■ Maximum select rows (300)  
  **Tip:** 0 returns all rows in the result set  
  **Note:** The total amount of returned data in the result set cannot exceed 50 MB, this limit is unaffected by the values of the Select Options. A message is displayed when this limit is reached. | N/A |

---

**Related Information**

- “Selecting an ad hoc statement” on page 84
Managing JES jobs

You can browse Job Entry Subsystem (JES) jobs running on the LPAR where the UIM server is active.

Viewing JES jobs

Use the following procedure to view JES jobs, job data sets, and job output.

To view JES jobs, job data sets, and job output

1. In the Job Browser perspective, click Add Job Filter.

To remove a job filter, click Remove a Job Filter.

2. In the Add Job Filter dialog box, enter a job name.

The wildcard * is supported.

3. Click OK.

The application searches for jobs that satisfy the filter value. Matching jobs are listed in the results pane.

4. To view the job output, perform one of the following tasks:

   ■ Double-click the required job.

   ■ Select the required job and click.

Two panes are displayed in the output view:

■ The upper pane displays the list of data sets.
The lower pane displays the contents of the data set selected in the upper pane. By default, the job output of the first data set is selected and displayed.

5 You can search for specific values and text strings in the job output. All standard RegEx values are supported.

6 Click and use the scroll bars to navigate between the job data sets. Click to reload an active job from the server. The jobs list and job output are updated. This button is dimmed when you are viewing details of an inactive job.

7 Click Back to Job List to return to the job list.

Related Information

- “Editing text files in Scratchpad” on page 61
- “Running a command” on page 65
Managing data sets

You can navigate to and edit data set members.

The File Locator perspective provides a visual hierarchical display of the data sets and members similar to that commonly found on personal computers.

Viewing and editing a data set

Use the following procedure to browse to, select, and edit any file on the IBM z/OS system that you are authorized to access.

1. In the File Locator perspective, click Add Data Set Filter +.

2. Enter a data set name.
   - The wildcard * is supported.

3. Click OK to search for all data sets and data set members (files) that satisfy your filter.

   The matching data sets and data set members are displayed in a hierarchical tree on the navigator pane. Details of the data sets and data set members are displayed in the results pane.

4. In the hierarchical tree, navigate to the data set that contains the files that you require.

5. (To open and view the data set) In the results pane, perform one of the following actions:
   - Double-click the file.
   - Select the file and click Open 🌳.
Tip
You can also right-click in the results pane and select 📧.

6 (To edit the file). In the results pane, perform one of the following actions:

- Double-click the file.

- Select the file and click Edit ✎.

Tip
You can also right-click in the results pane and select 📧.

7 In Scratchpad, view or edit the file, and save any changes.

8 If your data set is archived, respond to the displayed Restore Archive Data dialog box in either of the following ways:

- Click Yes to restore the data set.

- Click No to bypass restoring.

Related Information

- “Editing text files in Scratchpad” on page 61

- "Setting Scratchpad options” on page 67
Index

.csv 56

A
access to Workbench functions 23
ACTWBREP 28
ad hoc 84
advanced search 45

B
Bind command 59
BMC Workbench options 29
browse 52
browsers
  supported 19

C
case sensitive search 61
CATALOG MANAGER Options 57
catalog objects tab 93
changes to the product 10
command
  ad-hoc 60
  edit 64
  run 65
  statement cache 60
compare
  tab 93
comparing statements 80
comparison 80
connection manager
  refresh button 26
conventions, documentation 10
copy 56

view 52
copy file 61
copy workspace 35
cost 92
Creating a DB2 statement cache view 50
csv format 55

D
data set
  search 101
DB2 connection
  add 24
  delete 24
  favorite 24
  menu 24
  remove 24
DB2 navigation pane 49
DB2 object view
  create 45
DB2 privileges 19
DB2 statement
  grayed out 70
  selecting 82
  unavailable 70
DBC 19
DCL command 59
DDL command 59
debug messages 27
definition
  perspective 15
  view 15
  workspace 15
degree 95
  set value for 84
delete
  view 51
Delete command 59
delete index. See drop index
Display command 59

Index 103
documentation information 9
Drop command 59
drop index 77
drop recovery 67
  unavailable 67

E
edit
  ad-hoc DDL view 61
  command output 61
edit commands
  case sensitive search 61
copy file 61
find 61
redo 61
RegEx 61
replace 61
save 61
save all 61
search 61
undo 61
electronic documentation 9
element
  search 101
Explain diagram
  SQL tab 90
Explain tree
  SQL tab 90
  status information 90
export 55

F
filter options 29
find 61
folder
  add 39, 40
  create 39
  delete 39
Free command 59

G
Generated statements 79

H
HDDL command 59
dimmed 59
HDDL command
  unavailable 59
Help
  online 9

I
index
  copy 77
  drop 77
  edit 78
index name 73
index statistics 73
Insert command 59

J
job data sets 99
job output 99

K
key columns 73

M
message rules 92
messages
  debug 27
  error 27
  information 27
  warning 27

O
object icons 93
Object Types for HDDL 57
online application 95
online Help 9
options
BMC Workbench 29
DB2 Navigator 57
Scratchpad 67
OS
  supported 19

P
package
  selecting a statement 83
paste
  view 52
perspective
  definition 15
plan table owner 95
  set value for 84
predicates 92
product changes 10
publications, related 9

R
Rebind command 59
redo 61
RegEx 61
related objects
  selecting a table 93
  selecting an object type 93
  tab 93
  toolbar 54
  viewing 93
related publications 9
remove file view 61
remove index. See drop index
replace 61
rule set 95

S
SAF authorization 19
SAF resource 23
save 61
save all workspaces 35
save workspace 35
scratchpad 61
search 61
  advanced 45
Select command 59
select options 67, 95
select statement 81
server information 27
service unit
  cost per 95
SQL statement
  edit 88
  validation 88
SQL Tuning perspective 85
Start command 59
statement selection 81
status
  severe 90
  warning 90
status of workspace 31
step type
  index 90
  operator 90
  query block 90
  table 90
Stop command 59
string delimiter 45
subsystem
  not supported 45
summary of changes 10
superuser authorization 23
supported browsers 19
supported OS 19

T
tab
  indexes 88
table qualifier 95
  set value for 84
template 40
  create 40
  delete 41
  displaying 38
  managing 38
  remove 41
templates
  move 42
timeron
  cost per 95
total cost 90
TSO 21
U
UIM 19
UIM properties 27
undo 61
Update command 59
User Interface Middleware properties 27

V
view
copy 52
definition 15
delete 51
paste 52
viewing
job data sets 99
job output 99

W
What-If 72
what-if index
dimmed 73
unavailable 73
Workbench repository 26
workflow
SQL tuning 69
workspace
close 37
creating from template 33
creating new 32
definition 15
delete 37
edit 37
open 36
remove 37
saving 35
workspace icon 31
zoom
SQL tab 90